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Author Questionnaire:

1. Microscopy: Does your protocol involve video microscopy, such as filming a complex dissection or microinjection technique? (Y/N)  N
Can you record movies/images using your own microscope camera? (Y/N) N
If no, JoVE will need to record the microscope images using our scope kit (through a camera port or one of the oculars). Please list the make and model of your microscope.

2. Does your protocol include software usage? (Y/N) Y
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.

3. Which steps from the protocol section below are the most important for viewers to see? Please list 4-6 individual steps using the step numbers listed in this document. This information is important to prepare your Videographer for your shoot. (You do not need to include steps that will be screen captured. Please do not list entire sections.)
The protocol is mostly Screen recording, which will all be included.

4. What is the single most difficult aspect of this procedure and what do you do to ensure success? Please list 1-2 individual steps using the step numbers listed in this document. (Please do not list entire sections.)
Step 3.3; choose the correct size of the filter is essential. The size of the filter defines how much smoothing is applied to the images, which can be readily seen by clicking in the bottom right tab on the eye next to the smooth version of the image. This step determines the accuracy of the segmentation, and the size of the filter can be adjusted in case of poor segmentation.
Step 3.5; the semi-automated segmentation step depends on the quality of the preprocessing and the parameters (filter size, bias) used to produce the segmentation. This step involves qualitative assessment of the segmentation by visually checking that the software followed the structures of interest.
5. Will the filming need to take place in multiple locations? (Y/N) N
If yes, how far apart are the locations? 


Section - Introduction
Videographer: Interviewee Headshots are required. Take a headshot for each interviewee.

1. REQUIRED Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.

1.1. Corrado Calì: With the diffusion of automated serial section electron microscopy techniques, the rate-limiting step in the pipeline leading to the generation of biological three-dimensional models has moved to image processing [1].

1.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

1.2. Marco Agus: Our protocol provides a step-by-step guideline to produce a dense reconstruction of imaged volume in just a few days, combined with an approach for quantitative measurements using three-dimensional models [1].

1.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

OPTIONAL Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.

1.3. Maria Fernanda: With this technique, 3D-structure of tissues other than brain can potentially be analyzed to identify structural impairments typical of certain diseases and to improve the diagnostic strategy [1].

1.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

1.4. Maria Fernanda: Segmentation is a tedius step. Take the time to make it as accurate as possible to avoid proofreading a bad segmentation and having to restart the whole process [1].

1.4.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

1.5. Marco Agus: The design of the software is sometimes not very user-friendly. Therefore it is important to see the procedure to efficiently start work on the segmentation [1].

1.5.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.




Introduction of Demonstrator: (Said by you on camera)

1.6. Corrado Calì: Demonstrating the procedure will be Kapana Kare, the senior technician from my laboratory [1]/[2].

1.6.1. Interview style: Author saying the above 
1.6.2. Kapana Kare looks up from workbench or desk or microscope and acknowledges the camera.





Section - Protocol
2. Image Processing Using Fiji
2.1. Open the image stack by dragging and dropping the native file from the microscope containing the stack, or by dragging and dropping the folder containing the whole image stack into the software window [1].
2.1.1. SCREEN: To be provided by the authors - Screen capture movie as talent opens the image stack by dragging and dropping the native file from the microscope containing the stack, or by dragging and dropping the folder containing the whole image stack into the software window. Authors, please upload this screen capture to your project page.
2.2. Once the stack is opened, go to Image, Properties to make sure the voxel size has been read from the metadata [1].
2.2.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to Image > Properties to make sure the voxel size has been read from the metadata. Authors, please upload this screen capture to your project page.  
2.3. Transform the image into 8-bit by clicking on: Image, Type and select 8-bit [1].
2.3.1. SCREEN: To be provided by the authors - Screen capture movie as talent clicks on: Image > Type and select 8-bit. Authors, please upload this screen capture to your project page.
2.4. If the original stack is acquired as different tiles, apply stitching within TrakEM2 (trak E-M-two). Create a new TrakEM2 project using New, TrakEM2 blank [1].
2.4.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates New > TrakEM2 (blank). Authors, please upload this screen capture to your project page.
2.5. Using TrakEM2 embedded functions, segment structures of interest if needed. In the TrakEM2’s GUI (gooey), right-click on Anything under the Template window and select Add new child, Area list [1].
2.5.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to the TrakEM2’s GUI and right-clicks on Anything under the Template window. Talent selects Add new child > Area_list. Authors, please upload this screen capture to your project page.
2.6. Drag and drop Anything on top of the folder under Project Objects, and one Anything will appear there. Drag and drop the Area list from the template to the Anything located under Project Objects [1].
2.6.1. SCREEN: To be provided by the authors - Screen capture movie as talent drags and drops Anything on top of the folder under Project Objects, and one Anything will appear there. Drag and drop the Area list from the template to the Anything located under Project Objects. Authors, please upload this screen capture to your project page.
2.7. On the image stack viewport, select the Z space with the cursor. The area list will appear with a unique ID number. Select the brush tool on top and use the mouse to segment a structure by filling its cytosol over the whole z stack [1].
2.7.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects the Z space with the cursor. The area list appears with a unique ID number. Talent selects the brush tool on top and use the mouse to segment a structure by filling its cytosol over the whole z stack. Authors, please upload this screen capture to your project page.
2.8. Export the segmented mask to be used in ilastik (eye-las-tik) as seed for carving. To do so, right-click either on the Area list object on the Z space list, or on the mask in the viewport, and select Export, Area lists as labels tif [1].
2.8.1. SCREEN: To be provided by the authors - Screen capture movie as talent exports the segmented mask to be used in ilastik as seed for carving. To do so, right-click either on the Area list object on the Z space list, or on the mask in the viewport, and select Export > Area lists as labels (tif). Authors, please upload this screen capture to your project page.
2.9. Depending on the resolution needed for further reconstructions, reduce the pixel size of the image stack by downsampling. Consider the memory requirements of the software that will be used for segmentation and reconstruction; ilastik handles stacks of up to 500 pixels on xy [1].
2.9.1. MED or WIDE: Multiple shots of talent working at the computer. 
2.10. Take into account the minimum size at which the object still appears recognizable and, thus, can be segmented. Use Image, Adjust, Size [1].
2.10.1. SCREEN: To be provided by the authors - Screen capture movie as talent adjusts the image size using Image > Adjust > Size. Authors, please upload this screen capture to your project page.
2.11. To enhance contrast and help the segmentation, the Unsharp mask filter can be applied to make membranes crisper. Use Process, Filter, Unsharp mask [1].
2.11.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to Process > Filter > Unsharp mask. Authors, please upload this screen capture to your project page.
2.12. Export the image stack as single images for further processing in segmentation software, using File, Save as..., Image sequence and choose tif format [1].
2.12.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to File > Save as... > Image sequence. Authors, please upload this screen capture to your project page.
3. Segmentation (Semi-Automated) and Reconstruction Using Ilastik 1.3.2
3.1. In the main ilastik GUI, select the Carving module. Load the image stack using Add New and then Add a single 3D/4D volume from sequence [1].
3.1.1. SCREEN: To be provided by the authors - Screen capture movie as talent works in the main ilastik GUI to select the Carving module. Talent loads the image stack using Add New, Add a single 3D/4D volume from sequence. Authors, please upload this screen capture to your project page.
3.2. Select Whole directory and choose the folder containing the image stack saved as single files. At the bottom of the new window, where options for loading the images are present, make sure to keep Z selected [1].
3.2.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects Whole directory and chooses the folder containing the image stack saved as single files. Then talent brings the cursor to the bottom of the new window to show Z is selected. Authors, please upload this screen capture to your project page.
3.3. For the following steps, all operations and buttons can be found on the left side of the main software GUI. Under the Preprocessing tab, use the standard options already checked. Use bright lines, ridge filters and keep the filter scale at 1.600. This parameter can be modified afterward [1].
3.3.1. SCREEN: To be provided by the authors - Screen capture movie as talent brings the cursor to the left side of the main software GUI to point out the operations and buttons. Then talent navigates to the Preprocessing tab, and uses the standard options already checked. Talent uses bright lines (ridge filters) and keep the filter scale at 1.600. Authors, please upload this screen capture to your project page.  
3.4. Once the preprocessing is finished, select the next page in the drop-down menu of the Labeling module. One Object and one Background are present by default [1]. 
3.4.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects the next page in the drop-down menu of the Labeling module. One Object and one Background are present by default. Authors, please upload this screen capture to your project page.
3.5. Select the object seed by clicking on it, and draw a line on top of the structure of interest. Then, select the background seed and draw one or multiple lines outside the object to be reconstructed. Now, click on Segment, and wait [1]. 
3.5.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects the object seed by clicking on it, and draws a line on top of the structure of interest. Then, talent selects the background seed and draws one or multiple lines outside the object to be reconstructed. Then, talent clicks on Segment. Authors, please upload this screen capture to your project page.
3.6. Depending on the power of the computer and the size of the stack, segmentation could take from a few seconds to hours. Once it's done, a semitransparent mask highlighting the segmentation should appear on top of the segmented structure [1].
3.6.1. SCREEN: To be provided by the authors - Screen capture movie as segmentation finishes and a semitransparent mask highlighting the segmentation appears on top of the segmented structure. Authors, please upload this screen capture to your project page.
3.7. Scroll through the stack to check on the segmentation. The segmentation might not be accurate if it does not follow the structure of interest or spills out from it. Correct any spillover by placing a background seed on the spilled segmentation, and add an object seed over the non-reconstructed segment of the object of interest [1].
3.7.1. SCREEN: To be provided by the authors - Screen capture movie as talent scrolls through the stack, checking on the segmentation. Talent corrects a spillover by placing a background seed on the spilled segmentation, and adds an object seed over the nonreconstructed segment of the object of interest. Authors, please upload this screen capture to your project page.
3.8. Kalpana Kare: Accurate visual proofreading of the segmentation with iLastik might be tedious, but is essential to make sure that the exported objects do not contain artifacts [1].
3.8.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
3.9. If the segmentation is still not correct, try to modify with the Bias parameter, which will increase or decrease the amount of uncertain classified pixels accepted. Its value is 0.95 by default; decrease it to limit any spillover or increase if the segmentation is too conservative [1].
3.9.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to the Bias parameter and demonstrates how to decrease it and how to increase it. Authors, please upload this screen capture to your project page.
3.10. Another possibility is to click on Preprocessing and to modify the size of the filter. Increasing the value will minimize the salt-and-pepper noise-like effects but will also make membranes more blurred and smaller details harder to detect. This might limit spillover [1].
3.10.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to the Preprocessing tab and demonstrates how to increase the value to 2. Authors, please upload this screen capture to your project page.
3.11. Reiterate as much as needed, as long as all desired objects have been segmented [1].
3.11.1. MED-over the shoulder: Talent works to reiterate the object. 
3.12. Once an object is finished, navigate to Segment and click on Save current object. Two new seeds will appear to start the segmentation of a new object. Extract surface meshes right away as OBJ files by clicking on Export all meshes [1].
3.12.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to Segment and clicks on Save current object. Two new seeds will appear, to start the segmentation of a new object. Extract surface meshes right away as .obj files by clicking on Export all meshes. Authors, please upload this screen capture to your project page.
3.13. Visualize the model in 3D by right-clicking on Area list, Show in 3D. The following window asks for a resample number; a higher value will generate a lower resolution mesh [1].
3.13.1. SCREEN: To be provided by the authors - Screen capture movie as talent right-clicks on Area list > Show in 3D. In the following window asking for a resample number, talent enters a value. Authors, please upload this screen capture to your project page. 
3.14. Finally, export the 3D mesh as wavefront OBJ by choosing from the menu File, Export surfaces, Wavefront [1].
3.14.1. SCREEN: To be provided by the authors - Screen capture movie as talent navigates to File > Export surfaces > Wavefront to export the 3D mesh as wavefront .obj. Authors, please upload this screen capture to your project page.
4. 3D Analysis
4.1. After installing the NeuroMorph toolkit as described in the text protocol, open Blender. Import the objects using the NeuroMorph-batch-import by clicking Import Objects under the Scene menu to import multiple objects at once. Make sure to activate: Use remesh and Smooth shading [1].
4.1.1. SCREEN: To be provided by the authors - Screen capture movie as talent opens Blender and imports the objects using the NeuroMorph batch import by clicking Import Objects under the Scene menu. Talent activates Use remesh and Smooth shading. Authors, please upload this screen capture to your project page.
4.2. Select the object of interest from the outliner and modify the octree depth of the remesh function under the Modifiers menu. Work iteratively to minimize the number of vertices and to avoid losing details in resolution and correct morphology. When changing the octree depth, the mesh on the main GUI will change accordingly [1]. 
4.2.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects the object of interest from the outliner and modifies the octree depth of the remesh function under the Modifiers menu iteratively to minimize the number of vertices and to avoid losing details in resolution and correct morphology. Authors, please upload this screen capture to your project page.
4.3. Once finished, click on Apply to finalize the process. Navigate to the NeuroMorph menu on the left panel and use the image superimposition tool Image stack interactions to load the image stack [1]. 
4.3.1. SCREEN: To be provided by the authors - Screen capture movie as talent clicks Apply to finalize the process. Then talent uses the image superimposition tool Image stack interactions on the left panel, under the NeuroMorph menu, to load the image stack. Authors, please upload this screen capture to your project page.
4.4. Make sure to enter the physical size of the image stack for x, y, and x and select the path of the stack by clicking on Source Z. X and Y are orthogonal planes; they are optional and will be loaded only if the user inserts a valid path [1].
4.4.1. SCREEN: To be provided by the authors - Screen capture movie as talent enters the physical size of the image stack for x, y, and x and selects the path of the stack by clicking on Source_Z. Authors, please upload this screen capture to your project page.
4.5. Then, select a mesh on the viewport by right-clicking on it. Enter the edit mode by pressing Tab, select one or more vertices using mouse right click, and finally, click on Show image at vertex. One or more cut planes with the micrograph will appear superimposed on top of the mesh [1].
4.5.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects a mesh on the viewport by right-clicking on it, enters the edit mode by pressing Tab, selects one or more vertices using mouse right click, and clicks on Show image at vertex. One or more cut planes with the micrograph appears superimposed on top of the mesh. Authors, please upload this screen capture to your project page.
4.6. Select the cut plane by right-clicking on it. Then, press Ctrl Y, and scroll over the 3D model using the mouse scroll. This can also be used as proofreading method [1-TXT].
4.6.1. SCREEN: To be provided by the authors - Screen capture movie as talent selects the cut plane by right-clicking on it, press Ctrl + Y, and scrolls over the 3D model using the mouse scroll. Authors, please upload this screen capture to your project page. TEXT: See text for more 3D analysis


Section – Results
5. Results: 3D Reconstruction and Virtual Reality Analysis
5.1. Shown here is the segmentation and reconstruction using TrakEM2 and ilastik [1]. 
5.1.1. LAB MEDIA: Fig2_shooting.tif
5.2. The TrakEM2 GUI is shown with objects manually segmented, in red [1]. 
5.2.1. LAB MEDIA: Fig2_shooting.tif – Video editors, please zoom into the top left-most panel and emphasize the red objects.
5.3. The exported mask can then be used as input for semi-automated segmentation [1]. From ilastik, masks can be further exported to TrakEM2 for manual proofreading [2].
5.3.1. LAB MEDIA: Fig2_shooting.tif – Video editors, staying zoomed in, please slide over to the top middle panel. 
5.3.2. LAB MEDIA: Fig2_shooting.tif – Video editors, staying zoomed in, please slide over to the top right-most panel and emphasize the red circle.
5.4. Masks can be exported as 3D triangular meshes to reveal reconstructed structures. In this example, four neurons, astrocytes, microglia, and pericytes were reconstructed using this process [1].
5.4.1. LAB MEDIA: Fig2_shooting.tif – Video editors, zoom out a little and slide down to the bottom portion of the figure, showing the neurons, astrocytes, microglia, and pericytes.
5.5. A 3D analysis of reconstructed morphologies using customized tools is shown [1]. Here is an isotropic imaged volume from a focused ion beam-scanning electron microscopy dataset [2]. 
5.5.1. LAB MEDIA: Fig3_shooting.tif
5.5.2. LAB MEDIA: Fig3A_shooting.tif - Video editors, consider transitioning to this figure from 5.5.1 by zooming into the top left figure.
5.6. A dense reconstruction of this data reveals [1] axons… [2]; the astrocytic process… [3]; and dendrites [4]. 
5.6.1. LAB MEDIA: Fig3B_shooting.tif 
5.6.2. LAB MEDIA: Fig3B_shooting.tif – Video editors, please emphasize the grey image. 
5.6.3. LAB MEDIA: Fig3B_shooting.tif – Video editors, please emphasize the green image. 
5.6.4. LAB MEDIA: Fig3B_shooting.tif – Video editors, please emphasize the blue image. 
5.7. This micrograph shows examples of targets for quantifications [1], such as synapses… [2] and astrocytic glycogen granules [3]. 
5.7.1. LAB MEDIA: Fig3C_shooting.tif 
5.7.2. LAB MEDIA: Fig3C_shooting.tif – Video editors, please emphasize the white square labeled “1” and the corresponding magnification of the right.
5.7.3. LAB MEDIA: Fig3C_shooting.tif – Video editors, please emphasize the white square labeled “2” and the corresponding magnification of the right.    
5.8. The mask from that micrograph shows the distribution of glycogen granules around synapses [1]. 
5.8.1. LAB MEDIA: Fig3D_shooting.tif – Video editors, please emphasize the black circles.
5.9. Shown here is a graphic illustration of the input and output visualization of the glycogen-derived lactate absorption model, or GLAM (glam) [1]. 
5.9.1. LAB MEDIA: Fig3F_shooting.tif
5.10. Here, a user is shown wearing a virtual reality, or VR, headset while working on the dense reconstruction from a focused ion beam-scanning electron microscopy dataset [1]. 
5.10.1. LAB MEDIA: Fig4AB_shooting.tif
5.11. From a subset of neurites, an immersive VR scene can be observed [1]. The green laser is pointing to a GLAM peak [2]. 
5.11.1. LAB MEDIA: Fig4C_shooting.tif 
5.11.2. LAB MEDIA: Fig4C_shooting.tif –Video editors, please emphasize the green line towards the bottom-right.


Section - Conclusion
6. [bookmark: _GoBack]Conclusion Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
6.1. Corrado Calì: Ensuring the voxel size has been read is of primary importance as this determines the correct scale of the exported 3D object and determines if measurements reflect its actual size [1].

6.1.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
6.1.2. 2.2.1 can be shown here.
6.2. Marco Agus: The concept of serial section imaging, image segmentation, and 3D-reconstruction is fairly old. This current technical acceleration is leading to advances in connectomics and review of the neuroanatomy textbooks [1].

6.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.

6.3. Corrado Calì: Though this method was developed for brain research and electron microscopy, it can be generalized to any imaged tissue and microscopy technique generating volume data, such as 2-photon, confocal microscopy or more recently, light sheet microscopy. [1].

6.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
6.4. Marco Agus: Furthermore, any kind of 3D imaging technique can benefit from such image segmentation and reconstruction techniques, including CT scans and MRI [1].

6.4.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera.
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